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Coming Soon: SpecLink-E and Linkage to BIM

See “Coming Soon” on page 3

The second and final Beta release of BSD 
SpecLink-E is due on the street about the 
time you read this, and its long‑awaited 
public debut will follow the Beta version 
early next year. BSD SpecLink-E (SLE) 
is the next generation of BSD’s SpecLink 
product line. It is a version of BSD 
SpecLink+ that has been rebuilt from the 
ground up as a client-server application 
for use on networks of all sizes. It’s also 
small enough to run self-contained on a 
laptop in a single user environment. In a 
multi-user environment, the client software 
resides on each user’s computer and the 
server software resides on a central server. 
The data engine behind the BSD Data 
Server is Microsoft SQL Server, offering a 
more robust and higher performance data 
management system than is employed in the 
current MS Access-based SpecLink+. 

SLE’s support for large networks is a major 
new feature of the system. 

Beth Newman, BSD’s former head of 
Technical Support, now works for BSD as 
a consultant and leads the quality assurance 
testing program for new products. Beth 
now resides in Seabright, Nova Scotia, and 
she carries out her daily testing using client 
software installed on her laptop in Seabright 
with the server portion of the system
installed on one of BSD’s servers in Atlanta. 

She also tests the system in a self-contained 
installation on her laptop. We enlisted 
multiple Q/A staff to test the software both 
in-house and from other sites.
The new SpecLink-E is designed with 
a whole new approach to supporting 
individual users distributed across a 
network and potentially residing in different 
offices scattered across multiple states (or 
even countries). It uses Microsoft’s new 
Click Once installation technology that 
makes installing this type of software much 

easier. To install the client initially, a client 
setup package is placed on a network
server in a location where all potential 
users can  reach it. Each user then runs 
the setup package to install the client 
locally. Administrative permissions are not 
required, and no questions are asked 
during the installation. The software is 
installed automatically in each user’s 
Documents and Settings directory (or 
the Users directory if you are running 

Vista), and it starts automatically once 
the installation is complete. From that 
point on, the client essentially maintains 
itself, checking for software updates at the 
location from which it was initially 
installed each time it starts up. You control 
when updates are made available by 
deciding when to place a new client setup 
package on the network location being 
checked by the client software. Data 
updates are much easier, too. SpecLink-E 
will take advantage of your high-speed 
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Stragetic Partner

BSD SpecLink Helps Evan Terry
Associates Meet Clients’ Special Needs

Evan Terry Associates is an Architecture and 
Access Compliance Firm located in 
Birmingham, Alabama.
Evan Terry Associates, P.C., is a firm dedicated to 
providing its clients with highly professional archi-
tectural services. The firm’s reputation, built over 
the last 47 years, is one of excellent service, quality 
design and commitment to client interest.

Evan Terry’s design philosophy, based on a client-oriented approach, is to create solutions 
that exhibit the functional and aesthetic concerns and wishes of the owner. These solutions 
are developed to answer specific client needs with close client involvement throughout the 
process. A professional attitude, attention to detail, and adherence to schedules and budgets 
are all priorities at Evan Terry Associates.

Evan Terry Associates is committed to the “Universal Design” concept for facilities acces-
sibility. The architectural projects at Evan Terry are designed to ensure access to build-
ings and facilities for all people, including those with disabilities. Evan Terry’s work with 
the ADA has gained the firm a nationwide reputation as a leader in the field of accessible 
design.

The Need: In any automated specification writing process, the “master” document is 
where specification writers normally start. They will then add, delete or modify the various 
sections needed for the current project. Lawrence Hughey, Specifier, recalls, “We weren’t 
aware of it at the time, but our previous system was a much slower process.” Hughey knew 
that if he wanted to produce faster, more accurate documents, he needed to use SpecLink.

The Solution: Because accuracy of the specifications was so important, the quarterly 
updates from SpecLink made a huge difference in Evan Terry’s specification process. “With 
the old system, updating the master was exceedingly slow. Looking back, the referenced 
standards were generally more out of date. I am not aware of a more up-to-date specifica-
tion system than SpecLink,” Hughey stated. 

Hughey notes that time is important in this process, as well. “Updates now take 15 minutes, 
and they do not overwrite my changes.That means I don’t have to apply them selectively, 
which also saves time.”Additional time is saved through the intelligent links in SpecLink. 
Hughey describes his process in this way: “The linking feature is great. I generally start 
editing a section in Part 2 (Products), then move to Part 3 (Execution) and finish up in Part 
1 (General). Once the products are identified, most of the rest of the work is done automati-
cally by the intelligent links. And being able to add my own links helps save even more 
time.” Hughey estimates that his time savings are close to 50% using SpecLink.

The Outcome: Many of the project types Evan Terry Associates works on have special 
needs. Their recent work on a medical clinic called for a number of unique waterproofing/
dampproofing requirements. Modifying the Office Master to include these unique products 
and details presented no problem using BSD Speclink

Hughey recently joined Evan Terry Associates, and SpecLink was part of that decision-
making process. He says, “Choosing which firm to join was easy. Especially when I learned 
that Evan Terry Associates was already a SpecLink user.” The decision has been a good one 
for both the firm and Hughey.

New Section Synopses

084227/08445 AVNTI   
FRAMELESS SLIDING GLASS 
DOORS: 
Avanti Systems USA, Inc., 
frameless, partition-mounted, 
track-suspended, sliding glass 
doors for use with Avanti’s full-
height glazed interior glass 
partition system. 
www.avantisystemsusa.com	

10229/10660 AVNTI   FULL 
HEIGHT GLAZED PARTITION 
SYSTEMS:
Avanti Systems USA, Inc.;
frameless, full-height, single- or 
double-glazed interior glass 
partition system.  Options include 
curved or flat glazing, wood or 
aluminum top and bottom rails, 
dry or silicone butt joints,
swinging doors (frameless, alumi-
num-framed or  wood), integral 
blinds. 
www.avantisystemsusa.com
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Internet connection to update its Master 
database automatically. The continuously 
running BSD Data Server will periodically 
check BSD’s servers in Atlanta and download 
updates as they become available. This 
activity can be scheduled to take place 
at night or on weekends to minimize any 
performance impact on your network. 
The Master database updating process can 
take place unattended, and the subsequent 
marking of potential updates in each of your 
Projects is also automatic.
New features not found in BSD SpecLink+ 
include Find and Replace and Spell Check 
commands that span a whole project and 
allow you to select the project sections that 
will be checked. You can now add, modify 
and delete choice fields in a user version of 
a master paragraph without interfering with 
the master version of the paragraph. The new 
SLE optionally includes the ability to name 
the users that can have access to the system 
and assign Roles to those users (such as 
Standard, Expert and System Manager). The 
commands and features that each user can 
access and use are determined by the user’s 
Role. For example, Expert Users and System 
Managers have the ability to approve and 
apply Project updates, while Standard Users 
do not.
The last LinkLine issue described in some 
detail a new type of Outline and Short 
Form specifications management that 
will be available in SLE. All forms of 
specifications use the same body of text. 
In each section, Outline specifications are 
a subset of Short Form specifications text, 
and Short Form specifications are a subset 
of the Full Form specifications text. The text 
is designed to allow a specifications writer 
to begin a project using the Outline Form 
of specifications; rather than discarding the 
Outline text and starting over at the next 
phase, the specifier builds on the Outline 
text to create Short Form specs for the 
design development phase. Similarly, when 
preparing the final project specifications, the 
writer can build on the previously created 
Short Form specifications to create the
construction documents. This major feature 
is designed to improve productivity, maintain 
continuity from one type of spec to another,
and enhance the quality of the final product.

Continued from “Coming Soon” on page 1 LinkMan-E Follows SpecLink-E to 
Market
As we complete the initial release of 
SpecLink-E, we’re also designing and 
developing a Building Information Modeling 
(BIM) product called LinkMan-E (LME) 
that will initially link SLE with the Autodesk 
Revit Architecture product and provide a 
“dashboard” interface that lets you connect 
and coordinate your Revit models and 
elements with your project specifications 
in a meaningful way. LinkMan-E uses 
the UniFormat hierarchy to display Revit 
elements and connects them to its own set of 
assembly objects, whose constituent 
products connect to your project 
specifications. A second phase of this effort 
will link BSD’s CostLink/AE application 
with both Revit and SpecLink-E to facilitate 
budget development and quantification using 
linked assembly objects that are managed 
by the LinkMan interface.LinkMan-E is a 
client application similar to the SpecLink-E 
client, and it shares the BSD Data Server 
with SLE. It also shares the same SQL Server 
back end and uses the same BSD Master and 
Projects databases as SLE. This allows LME 
to change and update SpecLink-E text. The 
user can configure LinkMan-E to actually 
enable or disable specifications in SLE 
(based on the content of the Revit model), 
or you may choose to simply display the 
current status of the text in the LME interface 
compared to a product or assembly’s use in 
Revit. This display then becomes a de facto 
recommendation or coordination option that 
the user can act on  as appropriate.

LinkMan-E provides two views of the 
relationship between applications (for 
example, between Revit and SpecLink-E). 
The Assemblies view is structured using 
the UniFormat II hierarchy and reflects 
the Assemblies used or referenced in each 
application. Each Assembly lists the products 
that comprise its construction, indicating 
the status  of each product in the respective 
applications. The Products view is organized 
according to the MasterFormat 2004 
hierarchy and also depicts the use of each 
product in the respective applications.
Our approach to intelligent application 
linking does not depend on any keynoting 
scheme. While we plan to offer assistance in 
creating and maintaining keynotes that 

are coordinated with your specifications, 
we think the actual text of the keynote 
should be independent of the linking 
process. LinkMan-E depends on associating 
application information with LME’s own 
master set of objects (data definitions). 
Each application’s data is linked to these 
common objects and each application is 
thereby linked to the other applications’
data. BSD will deliver SpecLink-E master 
specifications that are “pre-linked” to 
LME’s objects. Each paragraph in 
SpecLink-E is a potentially linkable “object” 
that can be connected to LME’s product 
objects.  We are also working to pre-link 
Revit family types to LME’s objects.  
But the master set of objects is also 
expandable by the user, allowing users to 
copy and modify, or build from scratch, 
objects that match the various construction 
assemblies and products used in the Revit 
model. LinkMan-E allows users to build 
their own links between LME’s objects and 
Revit’s family types, and between LME’s 
objects and SpecLink-E paragraph objects 
(specification text). LinkMan-E will follow 
SpecLink-E, with an initial Beta Release 
a couple of months after the commercial 
release of SLE. If you’re a current 
SpecLink+ customer you are welcome to 
sign up early for either of these products by 
contacting support@bsdsoftlink.com. We 
continue to look for feedback and would 
welcome your comments. There are 
several of these articles on one product or 
another in our LinkLine Newsletter archives 
on our web site if you are looking for more 
information. And we’ll try to respond if you 
want to write with questions.
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All Products	
How do I customize my toolbar?

BSD applications enable you to con-
figure the appearance of the toolbar
using the Customize dialog box. 

To customize the toolbar:
1. Choose View > Toolbars and choose 
Customize from the resulting menu. The 
Customize dialog box opens.
2. Click the Tools tab.  This tab shows all 
of the available tool commands in each cat-
egory. The categories are derived from the 
application menus.
3. Select the Category of tools you want to 
work with. This changes the tools listed in 
the Tools area. To find out what a tool does, 
click on the name of the tool and then click 
the Description button.
4. To add a tool to a toolbar, drag the tool 
from the Tools area and drop it on any 
toolbar at the top of the BSD application 
window. Before you drop the tool, you will 
see a vertical line between the two existing 
buttons where your new tool will be placed.  
To remove a tool from a toolbar, drag it 
from the toolbar and drop it on the Tools 
tab.
5. If you want to change other display op-
tions for the toolbars (for example, display-
ing larger icons), click the Options tab and 
make your selections.
6. Click Close to close the Customize dialog 
box.
NOTE: These directions are for customizing 
existing toolbars. Reinstalling the current 
version or installing a new version of the 
application will remove your customization. 
You will need to customize your toolbars 
again after installing. You can also create a 
new toolbar for additional commands, by 
clicking the New button on the Toolbars tab. 
You can also add these tools to the menus. 
Instead of dragging the tool to a toolbar, 
drag the tool to the menu you would like to 

place it in, hold your mouse over the menu 
and the menu will open. Then move the 
command to where you would like it listed.

Is there a way I can have the soft-
ware always open the last project I         	

             worked on?
Yes. Click Start, Programs, BSD 
SoftLink Products and then right-

click the application. (Alternatively, right 
click on your shortcut.) Choose Properties 
and then click the Shortcut tab. Add a space 
and /OLP to the end of the Target line. Click 
Apply and then OK. Now your last project 
will be opened automatically when you 
open the application. This saves time when 
you are working on only one project for an 
extended period.

BSD SpecLink+

How can I globally change the font 
in my specification?
Go to the Tools menu and select 
Customize Styles. Click the Fonts 
tab and click the Fonts button to 

the right of each level. You can change the 
Font, Style, and Size in this box. This will 
change the font for the text within each 
section.
To change the font in the headers and foot-
ers, choose View | Show Header/Footer, 
highlight the header and footer text one 
line at a time and choose the font from the 
toolbar in the Customize Header/Footer 
dialog box.

I want to email my project to some-
one who does not have the software.   	

             How can I do that?
You can email an individual section, 
a division, or the entire project.  To 

do that, click the File menu and then select 
Print.  From the Report Setup dialog box, 
select Document as your Report to Print, 
and select Section, Branch or Project as the 
Scope of Report.  Then click the Export 
button on the right side of the dialog box.  
Select the folder where the files should be 
created.  You will have an RTF (rich text 
format) file for each section.  These can be 
emailed and/or opened in most word 
processors. If you have Adobe Acrobat 
Writer or Distiller installed, you can also
create pdf files.  From the Report Setup 

dialog box, change your default printer to 
Acrobat PDFWriter or Acrobat Distiller 
and print as normal.  Select the folder 
where the files should be created.

I’m thinking about making a check-
list document that the project 
manager will go through to select 

what is included in a particular job. I will 
create links from those selections that will 
activate the appropriate sections in the job. 
The only problem I have is that the 
checklist will print when I print the whole 
project, and it will be listed in my 
automatic table of contents report. Is there 
any way to get around this?

You can avoid this problem by
using Non-Printing Text. To add 

Non- Printing text to your project, just 
add new paragraphs and apply the NP 
(non-printing) or NS (non-selectable) 
tag to the paragraphs that should not print. 
You can apply the tags to individual para-
graphs within sections to keep them from 
printing. Or, to keep an entire section from 
printing or being listed in SpecLink’s au-
tomatic table of contents, apply the NP tag 
to the title of the section in the Document 
panel. The NP tags will then be applied 
automatically to the whole section..

    I want to add a new choice to a list 
    of choices in a paragraph so that 

whenever a new project is made based           
on this project, the new choice will be
available. How do I do it?

You can add choices to user-added 
or copied paragraphs. To edit an

existing choice list in a master paragraph, 
copy the paragraph, by clicking in it and 
using the Copy and Paste commands. In 
the copied paragraph, place your cursor in 
the choice field and then from the
Document menu, choose Choices/Edit 
Choice. To avoid confusion about which 
paragraph to use, you can mark the master 
paragraph as excluded and add a project 
note to it explaining which paragraph to 
use instead. Alternatively, you can create 
links that will automatically exclude the 
master paragraph and include your 
modified version of the paragraph.
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PerSpective Performance Specs 
Statistics:

•	 161 sections
•	 17,394 paragraphs
•	 22,296 internal links (targets and 

consequences)
•	 4,025 notes to specifier, 926 with live 

hyperlinks
•	 190 external documents referenced, 

with live hyperlinks to order 
information

•	 50 ASTMs referenced, 100% verified 
within last 5 months

•	 140 other documents referenced, 42% 
verified in the last 6 months

•	 38 standards organizations referenced

SpecLink+ Statistics:
•	 537 sections total, 195 updated (36%)
•	 530 non-proprietary sections

2 new sections,•	
•	 7 proprietary sections, 2 new
•	 56 sections with built-in checklists
•	 93,765 paragraphs
•	 109,002 internal links (targets and 

consequences)
•	 26,920 notes to specifier
•	 15,370 notes with live hyperlinks to 

Internet web pages
•	 2,226 external documents referenced, 

with live hyperlinks to order 
information

•	 974 ASTMs referenced, 100% verified 
within last 5 months

•	 1,252 other documents referenced, 43% 
verified in the last 6 months

About Your SpecLink & PerSpective Updates

Short Form Specs Statistics:
•	 16 sections corresponding to 

MasterFormat 1995 divisions
• 	 8,308 paragraphs
•	 1,564 notes to specifier, 1,023 with live 

hyperlinks
•	 9,232 internal links (targets and 

consequences)
•	 364 external documents referenced
•	 226 ASTMs referenced, 100% verified 

within last 5 months
•	 138 other documents referenced, 50% 

verified in the last 6 months
•	 42 standards organizations referenced

•	 189 standards organizations referenced
•	 2,492 manufacturer listings, with live 

hyperlinks to their web sites
•	 943 unique manufacturers listed in 380 

sections, 6 updated this quarter

 The documents not verified this quarter were updated within the past two years.

BIM and Contract Documents
Many architects and engineers have been experimenting with Building Information Modeling, or BIM, without any clear 
understanding of the legal issues surrounding this new technology. Now there is help available. In July of 2008, ConsensusDOCS 
released the very first construction industry standard document designed to address the legal uncertainties surrounding BIM. 
ConsensusDOCS 301 – Building Information Modeling (BIM) Addendum is intended for use on projects in which the owner and 
other major project participants have made an early commitment to use BIM or virtual design and construction.

ConsensusDOCS is a consortium of 22 organizations within the construction industry that have collaborated to produce standard 
contract forms that are fair and balanced, allocating risk equitably among the participants working on a construction project. A 
collection of over 70 standard construction contract forms is available from ConsensusDOCS in electronic form, and the second 
release of this collection includes the new BIM Addendum.

BIM is a technology that promises a more streamlined and less expensive construction process through the achievement of better 
coordination and the elimination of potential systems conflicts during the design stages of a project. However, because of the 
fundamental changes in architectural and engineering practice that effective use of BIM demands, there are many legal questions 
associated with its use. The BIM Addendum is expected to serve as a catalyst to help accelerate the use of BIM within the 
construction industry by clarifying the responsibilities and risks of the various parties.

According to the press release announcing the availability of this new contract form, there is actually less legal risk in moving from
the 2-D CAD world to the 3-D world of BIM. Richard Lowe of Duane Morris LLP, who chaired both the ConsensusDOCS BIM 
Taskforce and the AGC BIM Forum Legal Subcommittee, says that “Introducing the ConsensusDOCS 301 BIM Addendum does 
much to allay these fears, by providing a balanced, fair and practical way for all in the industry to proceed with a project using BIM. 
Now, hesitating to act may actually pose a greater legal risk.”

Building Systems Design, Inc. (BSD) developed the DocuBuilder® software that delivers the ConsensusDOCS contract forms in 
  collaboration with the Associated General Contractors of America (AGC), one of the founding members of ConsensusDOCS. 

“BIM ” contined on p.7
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Keeping HVAC systems running at optimal efficiency can save operating dollars. The fact that commissioning can help 
make HVAC systems run correctly in the first place or restore them to proper operation is recognized by both  the United 
States Green Building Council’s LEED Green Building Rating Systems and the Green Building Initiative’s Green Globes 
Rating System. Both organizations give credits or points for commissioning activities. LEED-NC includes basic commis-
sioning as a prerequisite and LEED-EB (2008) includes a prerequisite covering some basic commissioning activities.
If you are an architect, you may be wondering why you need to know about commissioning.  After all, isn’t that the 
mechanical engineer’s responsibility?  Unfortunately, the architect is likely to get involved with commissioning issues 
whether he/she likes it or not, simply because the architect is usually the primary project liaison to the owner.  
Commissioning is not typically included in new construction scope, so many owners question why they should spend
more money to “fix” the system the contractor is being paid to build.  In theory, if the contractor installs the equipment, 
piping, ductwork, and wiring in accordance with the contract documents, the system should perform as designed.  But 
HVAC contractors are not usually informed of how the system should operate, unless the system is to be provided under 
a design-build contract.  In practice, supposedly completed systems commonly do not operate effectively due to incorrect 
adjustment, improper installation, or other contractor errors.  Typical submittals and contract closeout activities, such as 
system startup and demonstration, do not provide sufficient evidence that the system is operating properly, much less 
optimally.
On projects involving existing HVAC systems, commissioning is generally considered a good value, even if no 
modifications are being made, because all but the simplest HVAC systems get “out of tune” over the years.  But 
retrocommissioning is “invisible” work just like commissioning of new systems -- owners question whether they are 
simply paying someone to find out that the system is already in good working order.  On the other hand, if energy 
conservation measures are being considered, the results of retrocommissioning may help evaluate alternative options 
and, at the very least, establish a reliable baseline for evaluating results.
The commissioning authority that does the original commissioning can also be contracted to prepare a Recommissioning 
Plan. This applies to both new and existing systems. The Recommissioning Plan is like the original commissioning plan
but is adjusted to reflect new knowledge discovered in the process and all modified or replaced equipment and controls. 
Some authorities recommend “continuous commissioning,” which involves building commissioning practices into normal 
operations and maintenance. In addition, formal recommissioning is made standard for each equipment replacement and 
system modification or extension. By having a written plan, good O&M practice is hard to overlook.
Finally, the architect, as the primary design professional, may get involved with the procurement of the commissioning 
authority’s contract, which is usually separate from the construction contract. If so, there are guides for Request for 
Proposal (RFP) documents by several professional associations. Even if the HVAC design engineer is responsible for the 
technical content of such a document, the contractual terms should be coordinated with the contract documents for 
construction – usually the architect’s responsibility.
Excerpted from “What Architects Need To Know About HVAC 
Commissioning, Retrocommissioning, and 
Recommissioning,” Archi-Tech Magazine, September 2008.  Get 1.0 
AIA LU for reading this article at www.architechmag.com.
See SpecLink Sections 019113, 019114, and 230800 for specifica-
tions on commissioning.
Another Recent AIA CES article by BSD:   
“What Architects Need to Know About VOCs” 
(October/November issue).

What Architects Need To Know About HVAC Commissioning, 
Retrocommissioning, and Recommissioning
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A BSD SoftLink® Publication

Editor: Brittany Smith  

LinkLine is published by 
Building Systems Design, Inc.  
Two Piedmont Center, Suite 300                            
3565 Piedmont Road, NE                                      
Atlanta, GA 30305

Permission to use excerpts in other 
publications is granted provided the 
publisher is notified in advance at 
404-365-8900.

BSD SpecLink, BSD CostLink, BSD 
SoftLink, and the BSD name and 
logo are registered trademarks, and 
CADLink and LinkMan are trademarks 
of Building Systems Design, Inc.

Get the latest on BSD by visiting our 
web page at www.bsdsoftlink.com

LinkLine

The software will look and feel familiar to 
users of BSD SpecLink, since it was
 derived directly from the BSD product. 
Additional information about the BIM 
Addendum, DocuBuilder, and the entire 
collection of ConsensusDOCS standard 
contract forms is available on the 
ConsensusDOCS website at 
www.consensusdocs.org, and on the
AGC website at 
www.agc.org/cs/docubuilder. 
The product can be purchased and 
downloaded from either website.

A more comprehensive look at 
ConsensusDOCS documents and how 
they compare with standard contract 
forms issued by the AIA and EJCDC 
can be found in the article 
“New Construction Contracts from Three 
Sources,” published in the Winter 2007 
edition of BSD’s LinkLine, at. www.bsd-
softlink.com/linkline/wint2007.pdf.pdf 

“BIM ” contined from p.5Our Featured Manufacturer:

This glazing type is specifically for 
SunGuard low-E glazing by 
Guardian Industries Corp. Guard-
ian’s SunGuard® series coatings are 
available in a variety of aesthetically 
pleasing colors and a wide range of 
performance characteristics meeting or 
exceeding energy code requirements 
and supporting most applications.  The 
2 coatings in the SuperNeutral series 
give a clear, neutral appearance 

with minimal solar heat gain.  The 7 
High Performance series coatings, in 
combination with clear, green, or gray 
glass, give a wide variety of color and 
performance characteristics.  

Visit www.sunguardglass.com for 
descriptions of color combinations, 
photos of completed projects, and a 
Performance Comparison Tool that 
shows detailed data for sealed insulat-
ing units, including each combination 
of glass type (monolithic or laminated), 
glass tint (color), coating type, coating 
location (e.g. #2 surface) and exterior 
appearance.

Guardian Industries also offers a com-
plete line of other architectural glass 
products, including UltraWhite™ low-
iron glass, heat strengthened and 
tempered glass, laminated and security 
glass, and patterned glass.

Contact SunGuard:
Request Samples or Info
Tel:  1-866-GuardSG
Tel:  1-866-482-7374
Fax: +1 (734) 654-0935
sunguard@guardian.com

Guardian Industries Corp.
SunGuard Marketing Department
14600 Romine Road
Carleton, MI 48117

www.sunguardglass.com

Congratulations BSD 
on 25 Years!
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AIA Members: We will report your course 
completion for 7 or 14 CES Learning Units

CSI Members: Submit Course Completion 
Certificate for 7 or 14 Education Contact Hours 

(ECHs) toward your CCS, CCCA, or CCPR 
Certification renewal

* Class starts at 9:00 AM and ends at 5:00 PM.

BSD CostLink/AE
1 day*  $595

Scheduled on a demand basis. 
Call 888-273-7638.

AIA Members: Submit Course Completion 
Certificate for 7 CES Learning Units

CSI Members: Submit Course Completion 
Certificate for 7 Education Contact Hours 

(ECHs) toward your CCS, CCCA, or CCPR 
Certification renewal

* Class starts at 9:00 AM and ends at 5:00 PM.

The BSD SpecLink+
Workshop

The BSD SpecLink+ Workshop comprises 
two one-day sessions.  The first day is de-
voted to learning the basics of SpecLink+, 
including how to navigate within the soft-
ware, start a new project, edit sections, 
understand how the links and choices work, 
and how to format, print and export final 
documents.  It is intended for new users.  
The second day is designed for those who 
want to learn how to create and maintain 
their own office master.  This session cov-
ers the concepts of an office master, how to 
customize your master by adding choices, 
links, and tags, as well as creating your own 
checklists.  Users must already be familiar 
with the basics of SpecLink+ to attend the 
second day.

BSD class schedules are online at www.bsdsoftlink.com. Select a product and click the Training link. Get directions & information on travel, hotels, & Atlanta




